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“WINe Cellar” Install:

- Files: All files will be copied to your hard drive if they do not exist or if the existing version is earlier.
There are two types of files: system files and application files (of the software).

Systems: they will be copied to the subdirectory "System" or "System32" or "Syswow64" of Windows. These are
only the original files made by Microsoft or with Microsoft tools.

Applications: a directory name will be required during installation.
- Launch of the installation:

After turning on your computer (yes!) and Windows started, place the CD ROM in the drive. If the installer does
not start automatically, start Windows Explorer, select the drive containing the CD Rom and after viewing the content, double
click the file "SETUP.EXE". Another possibility: use the sub menu "Run" from the File menu or Start menu in Windows and type
"D: \ SETUP" - if the CD Rom is in drive 'D' - followed by "Enter ". Now you have just to answer questions and follow the
instructions of the installer.

The installer adds entry in the Start menu to allow you to run the software, uninstall it and go to the website.

“WINe Cellar” uninstall:

Windows 9x, NT, 2000, XP, Vista, 7, 8, 8.1 and 10:
Always use the uninstaller sub-menu created when you install the software by clicking "Start", "All Programs”,
"Wine Cellar" and "Uninstall Wine Cellar". It is more complete and faster than Windows - "Add / Delete Programs ".

If you have created other files after installation, you must delete them from the directory as well as the repertory of “WINe
Cellar”. For system files, you can accept their removal if you are sure not to need them.

First use of ""WINe Cellar'":

At the first run of "WINe Cellar", a level control Windows installation is done and may ask you to install a "MDAC" most recent
only on oldest Windows versions. It is mandatory. The "MDAC" is on the installation CD or can be downloaded from the address
in the message. This file is a Microsoft product included in Windows since Xp..

WARRANTY:
Total by exchange for the support, total for failure to complete operation. No for use accounting or business.

If you encounter a problem (a real bug!), contact me and | will do what is needed to fix it and correct if necessary your data file.
By cons no guarantee is given when an external action has taken place (virus, crash, accidental deletion of data ...)

Being the first user of the program, | guarantee you the product tracking. | guarantee the other hand, 1 did not put any dangerous
or destructive code, and the only protection consists of: encryption and register your name and address in the program.

You can call me for any problems regarding the software, evening or weekend. This "Hot Line" is not limited as there is no
exaggeration. Even if you are in a case not covered by warranty, you can contact me and | will help you with pleasure.

Limitations:

This software cannot be used on more than one station at the same time and by different persons unless payment of licenses. The
licensee may install on multiple computers if he is the only user, or on a single station (the one of the owner) for multiple users.
By station means PC or terminal, network installation is reserved for owners of multiple licenses. Only the backup or backup for
security reasons is allowed.

Any exemption must be confirmed in writing by the author, single owner of the software.
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WINe Cellar Version 8

Your personal sommelier.

Whether you are a connoisseur of fine wines or occasional consumer, you've always dreamed, to have a well supplied
cellar. Can you ever be one of those happy owners of a cellar worthy of the great houses, which combines Sauternes, Saint
Emilion, Pauillac, Beaune and Chablis...? Even if not yet the case, the software "Wine Cellar" will be of great help. This very
French software allows you to manage efficiently inputs and outputs of bottles, knowing the composition and value of your cellar
and when to consume wine.

Discovery of “WINe Cellar”

This software is very easy to use and allows you to record your purchases of bottles to store them in your virtual cellar,
view at any time the composition of your cellar, find the location of a bottle and its period of consumption, before having to
descend into the coveted place where the pale light often misleads us. "Wine Cellar" will also allow you to print lists based on
very specific criteria: vintages, wines, appellations, etc... You can also annotate a wine, record the purchase price and the output
of a bottle to manage your consumption and even export your reports to a spreadsheet or to revise them in your way, either in the
raw or formatted "XML" format.

We will proceed to the constitution of your personal database, using an example quite subjective. You can of course apply this
example to your wine cellar, replacing the bottles directly quoted by yours.

WINe Cellar

WINe Cellar

B WiNe Cellar on the Web

or if you have created a shortcut on the desktop | W

Fig. 1 Fig. 1a
Launching “WINe Cellar”: open the menu Start, (Program), WINe Cellar... (Fig. 1)

In configuration network or if you set “Login” to start, you will get the following window (fig. 2).
With the reception of the software, you can use the following identifiers:
“Rey” password: “reyrey” complete use
“Rey2” password: (none) reading alone
“Admin” password: (none) administrator (identifiers and passwords).

Login

User : [Rey

Password : “uu| L

Forgotten password
oK Cancel

Fig. 2

A wait window reminding the software name and that of the licensee appears during the time of loading the database, long
time before the Pentium, and after very brief.
Finally appears the main menu of "WINe Cellar" (Fig. 3).
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Build your wine cellar

"WINe Cellar" offers a sample database, entitled "Cavetest. MDB" you can already view or edit. It is more interesting to
apply "WINe Cellar" in your own wine cellar. That's why you'll ignore this example. To manage your wine cellar you will have to
create a new database by going clicking to the "New" command from the File menu (Fig. 4).

The window allowing you create your new database appears and waits you enter the name of your file in the box labeled
“Filename* Title your file "Macave.MDB"(or "My préférée. MDB WINe Cellar") and click "Save" (Fig. 5).

A message asks if you want a pre-filled or empty file. File pre-filled with a number of countries, Soil (Terroir),
Appellation, colors and containers. This file is still under development.

After you have been asked what currency ($ or €) you want to attach the amounts entered, for the empty file, the program
will display the "Account" (Fig. 6), where you will enter details of the owner of the WINe Cellar. Later you can create other
"accounts"” to manage several Cellars in your file.

Automatically return to the main screen. Your file is currently completely empty (not for pre-filled file). We will have to
record information about your good bottles.

Automatically return to the main screen. Your file is currently completely empty (not for pre-filled file). We will have to
record information about your good bottles.
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ﬁ" WiNe Cellar V08.05 Open file X
&« v > Ordinateur » Dev(0:) » 01-VB6 » 01-Projets » 01- Cave Mdb » v Rechercher dans: 01 - Cave ...
J <] P
Organiser » Mouveau dossier ==« [H o
¢& OneDrive G Nom Madifié le Type Taille "

Documents caveavin - Copie.mdb 23/02/2013 1857 Microsoft Access .. 1212 Ke

3 Bernard Rey caveavin.mdb 26, 14 16&:53 Microsoft Access . 1212 Ke

= Grdinat caveavinX - Copie (2).mdb 231 Microsoft Access .. 1128 Ko
— rdinateur —

o caveavinX - Copie.mdb 23/02/2013 12:26 Microsoft Access ... 1128 Ko
Bibliothe =

r BOlotheques caverob.mdb 04/10/2012 1201 Microsoft Access .. 1172Ko

= LecteurUsE (Wi cavetest - Copie.mdb 15/02/201309:42  Microsoft Access .. 1560 Ko

o= Lecteur USB () cavetest.mdb 21/03/2017 17:10 Microsoft Access ... 1736 Ko

- LEcteur USE (Y?) E|J CAVETES T W4 mrmerfs Aroee - | 02/01/2017 17:30 Microsoft Access ... 1640 Ko

Type : Microsoft Access Database

= Lecteur USB (Z3) Eng.MdH -r[:i”c'l-:'f:'!rlﬁg- Tﬁ-"-g 017 710 25/01/201211:30 Microsoft Access ... 924 Ko

¥ Réseau Esp.Mdpl 208 ME 8o b il TR 25/01/2012 11:52 Microsoft Access ... 960 Ko

_Ij BERNARD-PC Espafia.Mdhb 25 Microsoft Access .. 1048 Ko

; (£ Fra.Mdb 25/ Microsoft Access .. 924 Ko
LIVEBOX =

— (75| MICHEL.Mdb 2 Microsoft Access .. 1292 Ko

B NAS-F9-9F-9E (BT Test00.Mdb 2 Microsoft Access ... 1112Ko

*& Groupe résidenti (71 Test01.Mdb 0 Microsoft Access ... 1016 Ko

Dev W E|J Testl2.Mdb Microsoft Access ... 1016 Ko W
MNom du fichier : |m v| "W-CELLAR' files(*.mdb]) ~

fig. 5

For each of the operations that will be stated here, you will have the choice between two modes of access. Either click on
the corresponding "Button™ in the main screen or you will unroll the "Menu" and call the desired "command", always from the
main screen. In order to leave you this choice, the two modes of access will be indicated to you each time.

%% WiNe Cellar V08.05 - Account - 'cavetestmdb’ Bernard Rey EUR — O >

Account
Owners :

Ilame:|Re~,r First Name :

Bernard

Adress : |22, rue de Pénide 33460 Arsac

Currencv : EUR New (:'..lrl'en(:?I = j C[E'atﬂ"mﬂd”:f Currenw
Initialize ‘ Validate Close
Fravel
Fig. 6
Wine Inputs
I
Fig. 7

To save your bottles, here's how: click "Wine Inputs"” or scroll down the menu "Data" and select the "Wine Input” (Fig. 7

and 8).
The window to enter "Wine" bottles appears (Fig. 9).




WINe Cellar User's Guide

* WiNe Cellar V08.05 'cavetest. mdb' Bernard R — O *
w oy
Data '
8 Wine Input Sl
= \Wine Output
3 Change Mvt Wing Outputs
B Delete Mvt
& Dish Class Standards Reports
® Dish and Recipes ol
- - N ey S S Specifics Reports
& Wine Food Pairing e _?_‘w'.‘;‘%”. e e a P pec p
Taste Sheet - e Aeya
Wine Labels To drink
1 New Storage

Fig. 8

You will fill it. The first box asks for the Wine Country. Then the second the Soil Wine. This is Land at large. Then the
Appellation. Then the Name of your wine. Every time you enter a new reference, a screen prompts you to confirm your entry. Say
the first wine you are recording is a Sauternes, Chateau Rieussec 1990. The country will be "France, the Soil will be" Bordeaux
"appellation is" Sauternes ", the selected color will be" White "or" Sweet White ". After entering the country or the Soil and you
type the key "Tab" to go to the next area, of course if the value does not exist, following message will appear: (Fig. 10). You will
need to confirm your entry and then another message prompts you to enter an abbreviated language optional (Fig. 11) if the

option was selected in the settings ("Options"). Same principle for color (Fig. 12)

Just click on "Yes" to confirm the new Country or Soil will be available later in the dropdown list. You will not have to reenter
this Country or Soil when you need it. Just select it from the list. Useful, right? This rule also applies to all areas along with a

small down arrow. Simply click on the arrow to expand the list and select the desired word or theme.

Third area to be filled: Appellation. Here we indicate the region of origin: here the region is "Sauternes". With the

confirmation of entry and short text where appropriate (Fig. 12, 13).

i“ WiNe Cellar V02.03 - Wine Input - 'cavetest.mdb’ Bernard Rey

Owner : Rey Bernard 22, rue de Pénide 33460 Arsac

O

WINe Cellar V08.05

() 1993 - 2020 Bernard Rey

*

Year :I vl
[EurR -

Purchase date :Ilﬂf23f202t|
MM/DD/YYYY

Unit Price :|

MNotes Labels

08.05.0263

Classification :I

Storage :I

To Drink After :I

Country || j Terroir :I j
Appellation :I j Colour : j
Title : Article : Wine :
| - [ - [ -
Supplier : Address [ Phone [ etc... :
| -l
Comment :I
Container :I j

Quanﬁt\r:l_ Balanoe:l—
-~

| E
Before:l—
Keep:l— Apogeel_l—

| Lccept

2

Close

Fig. 9

Field color will be" White "or" Sweet White ".




WINe Cellar User's Guide

Field "Title" awaits information such as: Domain, Chateau Clos, etc.. It may be that a wine does not have a title, select or
enter a "." (Period). Here the title is "Chateau".

Field "Article" allows, if necessary, by adding "d"™, "du", "la" ... which often abound between the title and name, which
make difficult selections and sorting in a database. In this area, they annoy you more. If an item has been entered by mistake,
select the first in the list is blank (spaces) to erase it.

Field "Wine" receives the name of your wine. Here, the name is "Rieussec”. Confirming and abbreviated wording possible.

WiNe Cellar V03.05 - Wine Input - 'testDl.mdb’ WiNe Cellar V02,05 - Wine Input - ‘test01.mdb’
9 The Country : France' does not exist 9 The Terroir : Bordeaux' does not exist
Do you want to create it? Do you want to create it?

08.05.0263 08.05.0263

Fig. 11
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Fig. 12 Fig. 13

WiNe Cellar V02.05

9 The Wine : Rieussec' does not exist

Do you want to create it?

08.05.0263

Fig. 14

Field "Supplier" allows you to select or enter a supplier. If you enter a new supplier, an additional menu will allow you
to enter all information (optional) on the supplier (Fig. 15).

Field "container"” is used to enter the type of container for your wine. They can be multiple: bottles, magnums, clavelin
cubitainer, drum, etc.. You can also enter the amount in cl. For your information, a bottle typically contains 75 cl of precious
nectar. Clavelin is to receive the famous yellow wine from Chéateau Chalon (Jura) contains 65 cl. It is true however that it is an
exception ... appreciated by connoisseurs. For your "Sauternes™ it is 75 cl. Confirming and text abbreviated (if any).

The "vintage year" refers to the year of harvest. It may be a few bottles in your wine cellar are not vintage. In this case

enter a period "." instead of the year. Here you can enter "1990".

Field "Quantity" allows you to enter the number of bottles Sauternes Chateau Rieussec 90 of your wine cellar. You have
three, you paid € 50 each. Enter this amount in the "Purchase Price". This field is not mandatory, but if you fill in, it will help you
evaluate the value of your wine cellar. The currency code is the one registered for the owner of wine cellar.

Field "Classification™ allows you to specify the classification of wine or its medals, which is normally indicated on the
bottle. In this case, chateau Rieussec is classified as "Premier Cru Classé 1855" - except errors. If this classification does not
exist, you will have to confirm its creation (Fig. 17).
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¥ WINe Cellar V02,05 - Wine - 'test0l.mdb' Rey - m} b4

WiNe Cellar V08.05 - Wine Input - ‘test01.mdb’

9 The classification : 1er Cru Classé (1855)' does not exist

Do you want to create it?

1

08.05.0263

fig. 17
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¥ WINe Cellar V02.05 - Wine Input - 'testdl.mdb’ Rey - O >
Damcire® ity WINe Cellar V08.05
{C) 1993 - 2020 Bernard Rey
Country :| France j Terroir - | Bordeaux j
Appellation :| Sauternes j Colour =| White j
Title : Article : Wine :
‘ Chateau j | j | Rieussec j
Supplier : Address |/ Phone [ etc... :
‘ Rieussec j |
Comment :|
Container :| Bottle j
Year: 1990 - Quantity : |3 Balance : | 3
Unit Price :[30.00  |EUR Classification : | 1er Cru Classé (1855) -
Purchase date :(10/23/2020 Storage :| j | J
MM/DD/YYYY
To Drink After z |12/1999 Before : [12/2020
Keep : 2025 Apogee : 2006 (2019
- Notes Labels ‘ Accept Close ‘
fig. 18

The "Storage" allows you to specify the location, rack that will host your bottle. This will avoid the search indefinitely
when you decide to drink. Again, entering this area is hot mandatory unless you have opted for graphic management of your wine
cellar even then you can store it later.

Field "Purchase Date" pre populated with the current date, you can specify a date which will be used by the commands
"Lists ..." to delimit the extractions movements through time.

The last box allows you to specify the period of consumption stimulated, either by producer or by wine shop or decided
by yourself. This field is not mandatory and remains highly subjective. It also appeals to some wine culture. Also, purists will
they want to excuse me for any misjudgments in the example presented (Fig. 17).

Four buttons at the bottom of the window allow you:
- To annotate a wine by writing a text of appreciation, an anecdote,
- To record a label (scanned, photographed, copied or drawn)
- To save the input in your base and go to the second recording,
- To close the window without saving and return to the main menu.

To practice, enter your second wine: it's a case of 6 bottles of Beaune Rouge, Clos des Mouches 1992, bought € 300 (the
box!) then € 50 the unit that you choose to store in "Test A" line "P", column "3" and following . To "store" wine use test file
(cavetest.mdb) otherwise you will have to create storage (see page 34 and following) or answer "no" to the request for storage or
change the option. The result is shown in Figure 19. You can continue to store all your wines. When are finished, click "Close".

Wine tasting notes:

This screen appears after clicking "Sheet Tasting" menu "Input”. The lines "Nuance" and "Sparkling" depend on the
category of wine. Print a blank form (without selection or with incomplete selection) to see details. When the selection is
complete, if data has already been entered, it appears and can be modified. Printing is done on an A4 sheet (fulfilled).For boxes
"Options" (a circle), one choice may be made by line. For check boxes (square), there are multiple possibilities for a title.
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¥ WINe Cellar V08.05 'cavetest.mdb’ Bernard Rey - O *
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The labels used for the radio buttons or check boxes can be changed in the file "English.lang" in sections [Fcave21] and
[Fcaved2]. For these labels, the two sections must remain the same. This file is located in the WINe Cellar directory and in case
of problems (loss, mishandling ...) you can always download it but before you edit it, do not forget to save it.

Do not forget that the boxes are fixed relative to the window and that their value will not follow the movement of label
and especially that any change can affect what you have already entered.

To delete a selection in “Problems” line, click on “Problems”.

You will now see how to use your database.

The right to error ...

The first operation that you may have to do is change the labels registered precipitately with may be some typos. To
change information, pull down the "Maintenance" menu and ask the command "Modify" (Fig. 21).

For the modification of elements (Class, Appellation, Wine..."), a detailed window appears allowing you to choose the
type of item, the corresponding words related to the type of item you choose and modify text chosen. Imagine that you have
mistyped "Clos des Mouches". Simply reenter corrected text in the "Modification:" text box of the window and click on "Accept"
(Fig. 23)

In a more radical way, if you simply want to delete a text, select the "Delete" (Elements), of the menu "Maintenance ..."
(Fig. 21). You can, for example, delete the name "Listrac", since you have created wrong and you do not restock your cellar with
bottles of this appellation. So select the type "Appellation" and the wording "Listrac" then click "Accept" (Fig. 24). Caution: If
you have or have had a a bottle of "Listrac" in your wine cellar, "WINe Cellar" will refuse to delete the item.

WiNe Cellar V02.05 'cavetest.mdb’ Bernard R —
ey O >
- Wine Inputs
Reports
Wine Outputs
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Specifics Reports
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bck  Previous Version {'%{}jfﬂ, 7 Browse
IEH Backup Management /é/ ('f? k
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7 A
Preferences 60 venclunge (1 fone VESEY Backup
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wrrsianios PAUILLAC coursais A .
Help Baron Thilimwe da Rerhuckile 5.+ = Exit
Fig. 21

For deleting movements, the menu to use is "Data" and the command "Delete" that you have to take to get the window
(Fig. 25) where you have to select the characteristics of the movement to delete before validating.
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% WiNe Cellar V08.05 'cavetest.mdb' Bernard Rey - O x

Modify

Record types :|Colour A Labels : J:[51MT:)
Appellation Bordeaux 1léres cites
Bordeaux Blanc
Bordeaux Rosé
Bordeaux Rouge
Bordeaux Supérieur
Bourgueil v

Modification : Country :|France

Abbreviation : Soil :|Elour_qo_qne

Valdate Close

Feave3

Fig. 22

Apart typos or spelling, it happens that you enter is a wine with the wrong vintage year or containing or name or a name
in the wrong appellation or a appellation under the wrong category. To correct this, the window "moves" is made (Fig. 26). You
must first choose the type of movement to perform and then select all the components of movement (or the component itself) to
move. As a result you should select the new component before validating. By here, the visit ..."

¥ WiNe Cellar V02.05 - Wine - 'cavetest.mdb' Bernard Rey - m} s

Modification wine

Chéateau Moulin de Tricot

Grape varieties : | j

Cabernet Sauvignon | 75,0 ﬂ
Merlot| 25,0 O/ ﬂ

Country : [France |

Soil : |Eord 2aux

Appellation : |Margaux

[ sparkling Wine

Title : - Article = -

Modification : ‘Moulin de Tricot

Abbreviation : [MdTr

Comment : ‘

Accept Cancel

FcaveB

Fig. 23

¥ WINe Cellar V08.05 "cavetestmdb’ Bernard Rey - O *

Delete

Labels : |Graves A
Haut Médoc

Record types :

Loupiac
Margaux
Margaux Rosé v

Country : [France

Soil : Bordeaux

Validate Close

Frave32

Fig. 24
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¥ WINe Cellar V02,05 'cavetestmdb' Bernard Rey - O X
Delete movement
Country :IFrance j Terroir :IBourgngne j
Appellation :IEeaune j
Wine :ICIUS des Mouches j
Colour :IRouge j Container :IBUuteiIIe j
08.05.0263 Vaidate Close |
Fig. 25

Once your wine cellar up, you will be able to visit it.

First operation: to know the full composition your wine cellar or consult a selected list. To do this, you will be able to see
the “Reports” at your disposal. In menu reports, use the command" Standard ..." or click on the button “Standard reports” in your
main menu. A blank window appears the first time then the last “Choice” is used. In the menu “Choice”, you will be able to
choose the sort your wine cellar. Choose the sort No. 10 showing in order: Country, Soil, Color, Appellation, Wine, Year and
Container (Fig. 27).

The sort is done column by column from left to right, alphabetically or chronologically. The result depends on extra
columns selected in Display menu. ”Summary” menu, allows you to display a summary with breakdowns by "Color, "Year" and
"Appellation” (Fig. 28). To return to the main menu, click "Close."

#* WiNe Cellar VOB.0S 'cavetestmdb' Bernard Rey — O X
Change of:
® Year O wine O Colour ) Price
O country O Terroir O Container O appellation
C supplier O Classification O storage O Title
Selection
Country :IFrance j Terroir : IEordeaux j
Appellation : IMargaux J Wine : IChateau Labégorce Zédé j
Container : IBoutelIIe I Colour : IRouge I Title : I I Year :|1985 'I
Mt :|05f2?f1996 1 wine output j Price Iﬁ Supplier :|
Classification : | Storage :I j
Modify
Country :IFrance j Terroir : IBordeaux j
Appelation : IMargaux j Wine :Ichﬁteau Labégorce Zédé j
Container :IBnuteiIIe vl Colour :IRnuge 'I Title :I vl Year: vl
price:[ Supplier : | 1074 8
Chassification I j Storage :I ig;g
1979 E
1981
1982
08.05.0263 1983 v

Fig. 26

10
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ﬁ" WiNe Cellar V08,05 'cavetest.mdb’ Standard report Report #10 Bernard Rey EUR - O x
Close Display Summary  Sort Print  Export
Country | Terroir | Co 1 Cont./Year/Colour/Appellation/Wine L | Year | Container | Classification | Storage | Qty| Price | Q
Espagne Alto Ebro Ro 2 Cont./Year/Count - " 1992 Bouteille Test A 1 3,35

. ry/Terreir/Colour/Appell./Wine ‘

p L cort/Colour/Anoellation/Wi 2003 | Bouteile [ |Test8 | 2] |
France Bordeaux Blz otiColonitpesilationiieieay 1989 Bouteille Cru Bourgeois Test B 1 50,00
France Bordeaux Blz 4 Cont./Country/Terroir/ Colour/Appell./Wine/Year 1997 Bouteille Cru Bourgeois Test B 5 50,00
France Bordeaux Ro 5 Cont./Colour/Appellation/Year/Wine 2001 Bouteille Test B 1
France Bordeaux  Rao . ) 1990 Bouteille TestD 1 4,57

& Cont./Counti Col Appell. !

France Bordeaux Ro geb ey ryﬂ_—erm"f DD_L"’{ EESEASaAN S 1975 Bouteille T-4 1 4,57
France Bordeaux Ro 7 Colour/Appellation/Year/Wine/Cont. 1975 Bouteille 5-1 1 4,57
France Bordeaux Rao 8 Country/Terroir/ Colour/Appell./Year/Wine/Cont. 1978 Bouteille 5-2 1 4,57
France Bordeaux Ro 9 Colour/Appellation/Wine/Year/Cont. 1982 Boute!lle S-3 1 4,57
France Bordeaux Ra . ) 1992 Bouteille A2 1

France Bordeaux Ro K Country/Terrair/Colour/Appell.,/Wine/Year/Cont. 1082 Bouteille R-3 1 4,57
France Bordeaux  Ro M Year/Colour/Appellation/Wine/Cant. 1990 Bouteille Test A 1 4,57

ngﬂcénn;iﬁgdrse:a{l;g, Ar?i D Year/Country/Terroir/Colour/Appell /Wine/Cant. 1981 Bouteille TestD 2 9.15 ¥

Fig. 27

Another possibility: to know the composition of your wine cellar for the 1989 vintage. You will request the command

"Specific" in menu "reports” or click on "Specific reports”. A window titled "Selection Criteria" appears and asks you to select
items for your search.

In this example, your single criterion is 1989 vintage. In the box at the top left, click on "vintage, click the option
"Value" (if not all vintages will be displayed) and choose 1989 in the list at the top right. If you have not bottles from 1989,
choose another year. Then click "Add to Selection” then "Accept” (Fig. 29).

A list will appear automatically showing you how many bottles of 1989 and possibly their value (Fig. 30).

i‘" WiNe Cellar V02.05 'cavetest.ndb’ Bernard Rey — O x
Owner @ Rey Bernard 22, rue de Pénide 33460 Arsac  Total : Containers: 199, Amount: 1 544,26 €uros
Colours Years Appellations
Quantity Amount Quantity Amount Quantity Amount
Blanc 12 300,00 2003 17 ||| Beauns [
Roasé 1 2002 [ Bordeaux Rosé 1
Rouge 18g 1 244,28 2001 2 Bordeaux Supérisur 3 22,83
149498 5 459,50 Canon Fronsac 2 4,57
149497 25 450,00 Champagne [
14945 23 lgl, 54 Cotes de Bourg 1 4,57
19594 25 15%9,87 Fronsac 2 1a,30
19493 16 55,485 Graves 1 4,57
14992 20 109,29 Haut Medoc 20 69,19
19491 3 9,45 Listrac g 51,82
19490 13 37,73 Margaux LT 945,75
14989 14 179,09 Médoc 11 24,14
14988 4 22,03 Moulis 3 g, 10
1987 5 106,71 Pauillac 3 7,682
1986 2 12,20 Pessac Léognan 5
14985 2 8,10 Pomerol 1 4,57
14924 1 7,62 Rioja 1 3,35
1983 3 13,29 Saint Emilion 4 a,10
lag2 2 4,14 Saint Estéphs [ 20,74
1981 5 38,42 Saint Julien 1
1978 1 4,57 Sauternes [ 300,00
1475 2 9,14 ¥ |[Yecla 12
Sort - M
08.05.0263 35 wines without price. Print Close
Fig. 28

You can print every time your report by clicking the print menu. You can also redesign your report into a spreadsheet

from a text file that you create by clicking the menu "Export".

To know when to consume, with the command "To drink" of the menu" Reports" or button "To drink” you can access a
selection window that asks you a date or period. By clicking on one of 6 choices and providing information where appropriate
like the Dates and then choosing the display of unit price or total price (option "Value" ), you will see a list of similar presentation
to "Standard reports " seen above.

11
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¥ WINe Cellr V0801 covetestmdb’_ Bemard Rey (USSR o (o) o]
Selection criteria

Country

Soil

Colour
Appellation
Wine
Container
Classification

Add to selection

: 1589

Fig. 29

% WINe Cellar V08.01 ‘cavetestmdb’  Specific E Bernard E EUE.LElﬂlg

Clese  Surmmary Print  Export

Year Amount

1989 _ 179,09

|T01:=|I Containers: 10, Amount: 179,09 €uros

¥ WiNe Cellar V08,05 'cavetestmdb' Bernard Rey — O bt
Country :IFrance j To drink
After 11171998
Terroir :IEordeaux j —f
Before :|12/2013

Appellation :IMargaux j
Apogee :I
Title :Ichﬁteau I Keep :l—

Wine :IMouIin de Tricot j

N CHATFAU
Grape varieties @49 MOULIN DE TRICOT

Colour :IRouge 'l |:| Sparkling Wine Cabernet Sauvignon 75,0% " H MARGALUX

Merlot  25,0%
Year :|1995 'l Container :I 'l

Quantity :| 10 Price : | 8,38 € Storage # ; !
ITestE j o MISEN DOUTEILLE AU CHATERD ®
IG, 1 vl Show the Storage ML cuace rev, e prea s meonesy (105910

Classification :|Cru Bourgeois | Bl e
Comment :| View
Supplier :IRey Claude 33460 Arsac j
WINe Cellar V08.05
08.05.0263 @ 1997 - 2020 Bernard Rey Wine Tastng MNotes | History | Cellar Book Close

Fig. 31

You can read the full specifications of a wine from your wine cellar by asking the command "Browse™" from menu
"reports™ or by clicking the "Browse" button of the main menu. The window in figure 29 appears.
If you assign a label to this wine, it will open in a preview window. For the assignment of labels, see page 26 and fig.33.

In window "Browse", select the Country, Soil, Appellation, Wine, Year, Container and color. You can fill in or change the dates
to drink at you wish. By clicking the "Close" button, you will validate the information changed or added and you return to the
main menu. Tip: After viewing a specific report or standard, a list of consumption, a mouse click with the left button on a

12
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i" WINe Cellar V08.05 'cavetest.mdb' Standard report Report# 10 Bernard Rey EUR - [m] *
Close Display Summary  Sort Print  Export
Country Terroir Colour Appellation Wine Year Container Classification Storage Price |
mmmm
Espagne Murcia Rouge Yecla Hécula Mew Wines outeille Test B 12
France Bordeaux Blanc Sauternes Chateau la Tour Blancl Exit Wines outeille Cru Bourgeois TestB 1 50,00
France Bordeaux Blanc Sauternes Chiteau la Tour Blanc outeille Cru Bourgeois TestB 5 50,00
France Bordeaux Rosé Bordeaux Rosé Chateau de Lucat Store outeille TestB 1
France Bordeaun Rouge Bordeaux Supérieur Chéteau Lacombe Cad MNew Price outeille TestD 1 4,57
France Bordeaux Rouge Bordeaux Supérieur Chéteau Landereau skt T-4 1 4,57
France Bordeaux Rouge Bordeaux Supérieur Chateau la Nauze Change... Year 5-1 1 4,57
France Bordeaux Rouge Bordeaux Supérieur Chéteau la Nauze Browse Container S-2 1 4,57
France Bordeaunt Rouge Bordeatnt Supérieur Chéteau la Nauze History Wine S-3 1 4,57
France Bordeaux Rouge Canon Fronsac Chéteau Barrabaque A2 1
France Bordeaux Rouge Canon Fronsac Chiteau Cassagne Hat il QECERGIED R-3 1 4,57
France Bordeaux Rouge Cétes de Bourg Chéateau Bujan Cellar Book Colour Test A 1 4,57
France Bordeaunt Rouge Fronsac Chéteau de Fronsac MNotes Price TestD 2 9,15
France Bordeaux Rouge Graves Baron de Montesquieu Grape Varieties Classification TestB 1 4,57
France Bordeaux Rouge Haut Médoc Les Ailes du Moulin ) eois Test A 5
France Bordeaux Rouge Haut Médoc Chéteau d'Arsac Neck labels Terroir TestB 1 6,86
France Bordeaux Rouge Haut Médoc Canterayne Bt Sug Country L-4 1 4,12
France Bordeaux Rouge Haut Médoc Canterayne Title 1 8,38
France Bordeaux Rouge Haut Médoc Canterayne Cancel L-5 1 4,12
France Bordeaux Rouge Haut Médoc Canterayne . Eouteille P-5 1 5,03
France Bordeaux Rouge Haut Médoc Grand Puysegur 1989 Bouteille TestB 1 5,34
France Bordeaux Rouge Haut Médoc Chateau Moulin de Tricot HM 2001 Bouteille Cru Bourgeois TestD 1
France Bordeaux Rouge Haut Médoc Chateau Pontillon 1983 Bouteille Q-5 1 4,57
France Bordeaux Rouge Haut Médoc Chiteau du Retout 1990 Bouteille K-5 1 7,55
France Bordeaux Rouge Haut Médoc Chateau du Retout 1993 Bouteille TestD 2 6,86
Total : Containers: 199, Amount: 1 544,26 €uros
Fig. 32

line of the list automatically opens the browse window filled with data from selected wine (fig . 31). Clicking the right mouse
button opens a menu Popup offering among other orders "Wine Input”, "Wine Output”, "Browse, "History"”, "Cellar Book ",
"Notes", "Print Setup "and close this menu (Fig. 32). The windows displayed will always be pre filled in with data from selected
wine.

If you wish to change the label, double click on it to get menu of the Figure 33.

To assign a label to a wine (on Country, Appellation, Wine, Year) you can either click on File menu, "Labels" or double-
click on label or its location in the windows "Browse" or "Cellar Book ", for the selection window labels (fig. 33). You can scan
labels with your scanner or search on the Internet.

If you chose "History"” you will get a window with the list of selected wine movements (Fig. 34). "The Book Cellar" is
brought to you figure 35, and “Notes” window figure 36.

To know what are the wines that have disappeared from your cellar, the command "Stock level zero " "of the menu
"Reports "will bring up the same report as before (standard reports) with the same choice for sorting and click with right or left.
Wines whose remaining amount is zero will be listed.

The menu lists of Input and Output Wines will show all inputs, outputs of wine made between two dates. The commands
"Standard Input Wine" and "Standard Output Wine" will display the window in figure 37.

If you enter a date from and a date until you will know the inputs or outputs of bottles and clicking "Accept" will display
the report window. You can choose sort criteria in the menu "Sort".

The commands "Specific Wine input" and "Specific Wine Output” will allow you more choice of selection criteria

through the window of the same name that will appear just after the window "Selection of Movements". The research will thus be
a little more refined.

Neck L abels:

List the standard inputs (Fig. 37 and 38). Click the right mouse button on the "Pop Up" menu (Figure 38). Then click the
command "Select for Neck Labels" to get the screen in Figure 39 where you can select / deselect a row by double clicking on this
line and change the quantity with a double click.

The neck labels (example Figure 40) are printed 9 per page (3 x 3) and are then to be cut and past around the neck of the bottle.
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i“ WiNe Cellar V02.05 - Wine Labels - 'cavetestmdb' Bernard Rey

Wine Labels

Criterion

Country : |France

=~

Terroir : |Bnrdeaux

B

Appellation : |Margaux

Tie :

B

Wine : |Mnu|in de Tricot

Colour : |Rouge -

Year:v

E

Find pictures

Look for an image file corresponding to the

f%ﬁ-’fﬁff

i e Dovied
{959

APPELL T 10 MARGALTY COMTROLER

CLAUDE REY

R

(R RN

selected wine clicking on 'Open File'. IR
g P QOpen fie... e, 0 7 T
View
Web Delete Close
08.05.0263
Fig. 33
ﬁ"" WINe Cellar V03,05 'cavetest.mdb' Bernard Rey — O

Owner :|Rey Bernard

Country : | France

Soil :|Bcrdeal.|:=<

Ledle

History

Appellation : |Margal_|:=(

Wine :|Chéteau Moulin de Tricot

E
|

CMour:|Rcuge __J Years 11995

Entries of 10/28/1997 & Btles 1995 Rey Claude 33460 Arsac
Balance on 10/1997 & Btles 1995
Entries of 10/15/2002 1 Btle 1995 PRey Claude 33460 Arsac
Entries of 10/17/2002 1 Btle 1995 PRey Claude 33460 Arsac
Entries of 10/23/2002 1 Btle 1995 PRey Claude 33460 Arsac
Entries of 10/23/2002 1 Btle 1995 PRey Claude 33460 Arsac
Balance on 10/2002 10 Btles 1995
Entries of 07/03/2006 2 Btles 19%5 Rey Claude 33460 Arsac
Exits of 07/03/2006 1 Btle 1985
Exits of 07/03/2006 1 Btle 1985
Balance on 07/20086 10 Btles 1995
Exits of 03/18/2017 1 Btle 1985
Situation on: 03/24/2017 9 Btles

WINe Cellar V08.05
=i © 1993 - 2017 Bernard Rey CE”a[ Book Erlﬂt Qlose

Fig. 34
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i‘ WiNe Cellar V08.05 'cavetest.ndb’ Bernard Rey EUR

Country : France

Comment :

¥ ion
WIS BN BOUTRILLE AL CHATEAL 0

Cellar Book

Chateau Moulin de Tricot 1997

Margaux Rouge

Terroir : Bordeaux

Classification : Cru Bourgeois

Balance : 20 Bouteilles on 10/23/2020

Grape varieties

:Cabernet Sauvianon............£2:0%....
Storage : TestB Merlot 25,0%
To drink after : and before : Apogee : Keep :
DATE INPUT OUTPUT U. P. AMOUNT BALANCE BALANCE AMOUNT |
TOTAL 3 1 11,50 20 230,00
20/01/2003 1 11,50 -11,50 20 230,00
15/01/2003 2 11,50 -23,00 21 241,50
15/01/2003 1 11,50 -11,50 23 264,50
09/01/2003 1 11,50 -11,50 24 276,00
16/12/2002 2 25
113300 ) 27 v
Notes:
e m Celar Map Print Printer Close
Fig. 35
¥ WiNe Cellar V08.05 'cavetest.mdb' Bernard Rey - O x
NOte,s Chateau Moulin de Tricot Margaux Rouge 1989
Acheté chez le producteur le 13/11/1994
Parfait avec les viandes rouges.
Doit pouvoir vieillir longtemps, @ maturité aprés 2000.
Modi Cancel
Fcaveb — ﬁ_,.r —

Fig. 36
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# WINe Cellar VOB.01 ‘cavetestmdb’ Bernard E@u

Movements selection

oAl

@ Since : to ; 01/04/2012
DD/MM/YYYY DD/MM/YYYY

Fig. 37
f’ WiNe Cellar V08.05 'cavetest.mdb’ Standards New Wines Report #10 Bernard Rey EUR - [m] x
Close Display Summary Sort Print  Export
Date Counti Terroir Colour Appellation Wine Year Container lier Price
Clos des Mouches EEIF_"""""‘“_-_
03/19/2012 Espagne  Murcia Rouge Yecla Hécula 200 New Wines
07/03/2006 France Bordeaux Rouge Margaux Chateau Moulin de Tricot 199 Exit Wines 2 8,38
02/18/2006 France Bordeausx Rosé Margaux Rosé Rosé de Tricot 200 Supplier 12 1,00
07/02/2006 France Bordeaux Rouge Haut Médoc Les Ailes du Moulin 200 PP 6
11/08/2005 France Bordeaux Rouge Haut Médoc Chateau Moulin de Tricot HM 200 Store 1
01/08/2003 France Bordeausx Rouge Margaux Chateau Moulin de Tricot 199 Change , 2 11,50
02/04/2003 France Bordeaux Rouge Margaux Chateau Moulin de Tricot 109 g 1 10,00
01/25/2003 France Bordeaux Rouge Margaux Chateau Moulin de Tricot 199 Browse 1 10,00
01/22/2003 France Bordeausx Rouge Margaux Chateau Moulin de Tricot 199 History 1
01/21/2003 France Bordeaus Rouge Margasx Chateau Moulin de Tricot 199 Wine Labels 2
01/20/2003 France Bordeaux Rouge Margaux Chateau Moulin de Tricot 199 2
01/15/2003 France Bordeaux Rouge Haut Médoc Chéteau du Retout 199 Calerlals 1 9,50
12/19/2002 France Bordeaux Rouge Listrac Chéteau I'Ermitage 199 Notes 1 7,62
12(19/2002 France Bordeaux Rouge Margaux Chateau Moulin de Tricot 199 Grape Varieties 2 5,34
12{16/2002 France Bordeausx Rouge Margaus Chateau Moulin de Tricot 199 1
12/14/2002 France Bordeaux Rouge Haut Médoc Chateau du Retout 199 Neck labels 1
10/11/2002 France Bordeaux Rouge Margaux Chateau Moulin de Tricot 199 Printer Setup 2 13,72
10/23/2002 France Bordeaux Rouge Margaux Chateau Moulin de Tricot 199 1 8,38
10/23/2002 France Bordeaux Rouae Maraaux Chateau Moulin de Tricot 199 Cancel 1 8.38 Vv
|Total : Containers: 382, Amount: 1 555,32 €uros i
Fig. 38
Py ',

ﬁ’ WINe Cellar V08.01 ‘cavetestmdb' Bermnard Rey EUR E u \
Sel.|Wine 1
) [Beaune 2002 Red Clos des Mouches, Bourgogne, France 6

Margaux
<= ' Chateau Moulin de Tricot
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You have to see how to record the output of a bottle from your wine cellar. Nothing could be easier. Select the "Exit
Wine" of the menu "Data" or click on "Exit Wine". A window similar to input entries appears. Simply select wine according to
different criteria and, after entering the quantity and possibly changed the release date, click the Accept button (Fig. 41). You will
just go and get it from expected location - if you indicated before - and enjoy at your convenience.

You can of course create as many wine cellars as you like, if you want to manage the cellar of a friend, for example. To
access the cellar that you want to manage, simply select the command "Open" from the File menu or click the Open button, or if
you created multiple "Accounts, click on menu "File” , "Owner" and select an "Owner". If you use the "Owners ", you will reuse
the input constants (Categories, appellations, Titles, News, Wines, Suppliers, containers, vintages ...)

If the picture shown in the center of the main menu does not suit you, you can choose another, calling the command
"Picture”, from the File menu or clicking twice on the label. A selection of images compatibles is shown. Simply choose one by
clicking it and selecting "Open™ (Fig. 42). The main menu can be resized as you need, the shape of the picture does not matter.

The new image replaces the old in the center of the main menu (Fig. 43). If some labels have been scanned the others were
drawn using "Paintbrush" - drawing software for Windows ® 3.x - Tricot88, 91, Ligondras, Tertre. Since Windows ® 95
"Paintbrush" became "Paint".

% WINe Cellar V08.05 - Wine Output - 'cavetestmdb’ Bernard Rey — O *
Owner : Rey Bernard 22, rue de Pénide 33460 Arsac WI Ne Cellar Vas. 05
(C) 1993 - 2020 Bernard Rey
Country :|France j Terroir :|Bnrdeaux j
Appellation :|Margaux j
Title : Article - Wine :
(Chateau | |Moulin de Tricot |
Colour : |Rnuge j Container :|Bnuteille j
Year:|1995 ~ Browse ‘ Quantity :/1 Balance :| ?
Price : 8.38 £ Classification :|Cru Bourgeois
Output date : |10/23/2020 Storage :| j
MM/DD/YYYY
To Drink After :|11/1998 Before : (12/2013
Keep :|2026 Apogee : (2009 |2013
08.05.0263 Taste Sheet ‘ Motes ‘ Accept Close ‘
Fig. 41
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i‘" WiNe Cellar V08.05 Central Picture x
< v A <« WIMe Cellar » Images W & Rechercher dans: Images el
Organiser = Mouveau dossier = ~ [N 0

Windows Mail ~ » e T - A
Windows Media Pla : — ,

MR2001.jpg Menin24.JPG Palmer®l.jpg
Windows Multimed Ty
Windows NT 3 - l

o P Al -lr:l"'\'

Windows Photo Vie g %
Windows Portable [ IS B ”'LL_"' =
Windows Sidebar PICHERIEJPG Poujeaus.jpg
WindowsPowerShel e -

.‘-l-“*“_? .....
WiNe Cellar ﬁ C

L
Images 3 A
-H_{._I-E_..;q.l_f ..... -
Recovery -
System Volume Infon Tayac,jpg TRICOT29.PG Tricot35.JPG Y
Mom du fichier: | TRICOT25.JPG ~ | | JPeg(*JPG) o
Chuwerir Annuler
Fig. 42
i" WiNe Cellar V0804 'cavetest.mdb' Bernard Rey — O
e EE—

File , s Wine Inputs

£ Owner (/Té:ﬂ."??fff | 7

51 New oy e Wine Outputs

& Open bevdon de ot

Bcture prn : Standards Reports

E Backup =

E] Restore

@ Exit | . Specifics Reports

| - | 2

Data I To drink

™ rocal =
| el i el
Reports . MARGAUX S
APPELLAT I HARG AL COMTRALET B
Browse - A HEL
CLAUDE RE
I — —." Backup
. ETVRE A4 A i
Maintenance : el % 05 HEELUTRILLE AL ATTFR
|y . : Tl || -
EI'Ef'EfEﬂCE’S ;I SR I 'h'_rl—gl—l.:':‘.. I.I —_— - '-"—'Ii-'J Ezft
Fig. 43
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Now why not a graphical representation of your wine cellar?

Before you can manage your cellar graphically, we have to represent your storage. So click on the File menu, "New
Storage" to display the first window of creation (Fig. 44).

%% WiNe Cellar VOB.OS  'cavetest.mdb' Bernard Rey - O *

New Storage

Storage Name : IStr #1

Format Lines Columns
© Bins / Racks Number :|19 Mumber I}‘1
{2 Harnois 1 (screen 1920 and +) Numbering : Humbering :
{2 Harnois 2 (screen 1680 and +) Numeric (*) Numeric
i) Harnois 3 (screen 1440 and +) (*) Alphabetic Alphabetic
[]1n staggered rows [[] Descending (Down -= Up) [ ] small letters
|:| First line moved to the right D smell letters
[ ] Double row (head to foot)
Sereen resolution : 1920 X 1080 Next > Cancel
08.05.0263
Fig. 44

Say you have bought 5 "boxes" stacked one above another, and that in each box you can store a first layer of 7 bottles,
then a second of 6 bottles and a third of 7 bottles (staggered). You will therefore 3 x 5 "lines" more 4 intervals be 19 lines in total
and 7 columns. Without forgetting to check "Staggered". You just click on “Next” to get the first draft, do not worry, you can
reverse.

In this screen (Fig.45) we will have to remove the green circles too many by clicking with the left mouse button and if
you're wrong, again click the right mouse button. Assuming the 5 "boxes" of 3 rows of 7 - 6 - 7 bottles, you get what you see in
Figure 46. Want to see the result? Then click "Next" or if you are wrong "Back". If you clicked on Next, you will get the final
window of the series, for validation (Fig.47). There you can click "Finish" or go back by clicking "Back".

& WiNe Cellar V07 2W PR e & WINe Cellar V7.2 ‘testimdb’ Bernard 'Rey‘ [E=NEER

Storage : Test B Storage : Test B
1234567 | 1 2 3 45 6 7
5 XD e @
¢ (IXIXNLS ¢ IO X L)
G0 00000 r 9900009
0008000 e (U OU0)
0808000 6 (LXK )
H R0 + 9900008
) TYEYTTT) y OOUUe
« (LXYYXYT o (R0 X )
eGS0 0000 . 9999900
v QO w OO0
000000 n OOOOOOe
o (XYXIXYTL o QUUOOT0
G000 00 » 9990009
e QUCOOL0 o QUOOOO0
0080000 NG00S0
s (XX XXX XS s (00

Pasition ;| Re 3

Fig. 45 Fig. 46
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% WINe Cellar VO7.22 ‘testimdb’ Bemard_ Lo e

Storage : Test B

| i1 2 3 45 B 7

0O m =

- m 2

I o

— 7= —

o = =

Position : | 100 Bottles <Back | Fnsh | cancel

Fig. 47

Well, let us see how to use it.

To access them you must have checked the "Cellar Map" in the Options window (Fig.53). Then you can "store" your 6
bottles when entering a “new wine” or later from a standard report or report "Wines to store™ by clicking on a wine line with the
right mouse button and by selecting "Store". You will get a first window to select the Storage (Fig. 48). Click on "Test B" for
displaying the next window where you click on green circles (= free) for 6 bottles, and then click on "Accept" (Fig.49)

To view your storage, move bottles in storage click the menu Browse, Cellar and choose the Storage in the list (Fig 48)
to get the window in Figure 50. By moving the mouse cursor over the bottles, you will get the name of the wine.

If you want to move a bottle between two locations of the same Storage “catch” it with the mouse and drag & drop it. Do
not forget to do the same effectively and carefully in your cellar.

If you want to move one or more bottles between two storages, you must use the menu “Maintenance”, "Move," select

"Storage" then the storage origin and destination, the order does not matter (Fig.51). Using the mouse, you can move your bottles
in one direction or another and even within storage.

In the series “Tips and Tricks”:

In all lists of style of Figures 27, 32 and 38 you can reverse the sort criteria of a column by clicking on the title of this
column, as in Windows Explorer.

If you have many bottles to enter, you can speed up entry by not checking the option to manage your cellar graphically
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and once finished typing, select it and store your bottles later through the " Standard Report "or "Wines to store” menu: click the
right mouse button on the wine to store and on "Store " in the menu that opens.

On the other hand, the storage when entering a new wine is not mandatory and if you do not, a message asks if you want
to do it later. However, for stunned (and others), by clicking on the menu "Reports"”, "Wines to store", you get a list of wines to
store in the style of "Standard Report" where you can use the click with the right button to get the menu "Store" . If you wish to
be informed of the existence of wine to store when leaving the software, you simply check the option "Reminder” in window
"Options"(Fig. 53)

i ™
o WINe Cellar V08.01 @

Wine Cellar Browse

Fig. 48

Ly, e

Storage : TestB

1 2 3 45 6 7

Legend

# Fed & Other
‘wihite & Actual

& Fink & Free

Pogition ; I 0.3 [ Accept ] [ Caricel

Fig. 49
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g WINe Cellar V07,02 ‘testmdb" Bernard Rey =

Storage : TestB

1 2 3 4 85 6 7

|Eeaune Clos des Mouches 1992, Rouge, Bottle

Leqend

& Fed & Other
white & Actual

Posiion:| 0.5 9/100Bomes @ Pk @ Free

Fig. 50
JF Wike Cellar V07.00 “cavetestmab’_Bermard Rey I @
| Test A <--> Test B

1 2 3 45§ 1 2 3 4 5 5 7 I
: S A A .m |
c < e O‘O.C.C‘C‘C.O
5 €,
e 2,
. <, =,
c 2,
" <, =,
| R 5
) < ol Ny
¢ 0, |
L < e e
W 0, |
N 2, ¢
0 <, a2 L
b + 4+ +
0 4+ 4+ y
A + 4+ + ¥

444
] bt o A A 4 oA A oA
T AN

Legend
@ Red & Other
wihite & Actual

& Fink & Free
Positon: | 25 /100 Bottes Posiion: | 84/ 100 Botlles

Fig. 51
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""Preferences' menu: This menu contains the commands "Printer Setup", "Printer Adjust” (Fig.52), "Options" (Fig. 53
to 56) and 3 commands Language: - "English" , "Spanish" and "French" for today -. If you are able, you can add more.

So you can configure your printer set (define) your reports, choose options and change the language. And thanks to the
submenu, "Backup" in "File" menu you can copy your files wherever you want (Fig. 57).

-
i“‘ WINe Cellar VO8.01 'cavetestmdb’ Bemard Re_

Printer Adjustment

Select the letter in each listbox for the first visible printed line.

I Results Top: bottom: |
I Left: Right: I

o |

Start Printing

‘ Accept ‘ ‘ Cancel

e N e 2w

Fig. 52

After clicking , "Start Printing " and got a page with lines numbered at the top, bottom, left and right, select in the
corresponding lists, the limits of your reports.

Options:

The "General" tab of the options (Fig. 53) allows you to specify some general settings; “Reminders” will generate
display of any message if you still have to store wine.

Cellar Map

Close Menus

Button 'Browse' (10)
Autormatic Update
Ermailing errors
Remind storage
Confirm 'O

¥ WINe Cellar V02.05 'cavetest.mdb' Bernard Rey — O ot
Options
‘General Export | Movements sort | Other
— Parameter —Action
Tooltips Display Tooltips
[] Login User control in net use or not.
[] Abbreviations Use or not abbreviations.

Graphic management of the Cellar.

Close unused Menus (one opened at a time)

Show button 'Browse' in Wine Input and Wine Output screens
Look for updates on start

Prepares to send the program errors by email

Display message boxes to remind.

Message to confirm 'Mew Wines' and 'Exit Wines'

08.05.0263

Validate Cancel

Fig. 53
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¥ WiNe Cellar V08.05 'cavetestmdb’ Bernard Rey — O >
Options
General T Export 1 Maovements sort 1 Other )
—Format
{O Spreadsheet: Text Format (CSV)
O HTML
O XML

{# Excel (must be installed)
Harnois: Sort export by cell

rExport data

Enter the fields and decimal separators for exportation to spreadsheet. The characters usually used are the semicolon
;' and decimal point .".

Field separator I,_ Decimal point :I,_

08.05.0263 Validate Cancel

Fig. 54

In the "Export" tab, (fig. 54), you choose the format used for exporting the various reports, "CSV" format is for
spreadsheets and formats "XML" and "HTML", can be opened in your Internet Browser. With the last format, "Excel", will open
automatically, so that software must be installed on your computer.

¥ WINe Cellar V03.05 'cavetestmdb' Bernard Rey — O ot

Options

General 1 Export 1 Movements sort! | Other

movments Lists
Sort by date (first)
{O By month (Year, Month)

{¥) By day (Year, Month, Day)

Date sort order
& Ascending
{*) Descending

Valdate Cancel

FcaveE

Fig. 55

In the "Sort movements" tab (fig. 55), you can add a date to the lists of movements, the date on which you can sort in
descending or ascending order. You can also reverse the sorting by clicking on header of the column "Date", when viewing in
window.
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¥ WiNe Cellar V08.05 'cavetest.mdb’ Bernard Rey — O bt
Options
General T Export | Movements sort 1 ‘Other
Farameter Action
[] Mew wine Coupon Print a 'label’ for each new bottle (1/3 Ad4)
Help File Help File presence required
Translation Mo automatic translation message on starting
Recipe Title Inserts the title of the recipe when entering the text for the first time
Proportional Enfargement Proportional enlargement according to the setting of each screen
(contextual menu)
. S Valdate Cancel
Fig. 56

When you take a bottle of the blue, you do not immediately capture the "Exit". With this option, you can print a note for
new wine per bottle, this note, by cutting and collapsing you can roll it around the neck of the bottle with a rubber band. Leaving
the bottle put the note hand and you can enter the exit later.

The second option allows you to make mandatory the presence of the Help file and the third to have or not translation
messages.

¥ WiNe Cellar V02.05 'cavetestmdb' Bernard Rey - O d

Backup
Save Data

C:\Program Files (x86)\Cave\SaveCave20170324120901.MBK

Open fie...

Save Parameters
C:\Program Files (x86)\Cave\SaveCave20170324120901.PRM

Backup indicator when exiting
Backup Cancel

FeavelC

Fig. 57

Wines-Dishes Accordance:

Do not expect sentences such as: "With such dish you must drink such wine" (or vice versa!). So you will decide
according to your tastes, but you can get help from the dealer or producer who sold you the wine or even find this information to
some cookbooks.

What | am proposing is to create a accord between dish and wine.
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On the main menu, click "Data" to get window of Figure 8. The last 3 commands interest us:
Dish Class
Dish and Recipes
Wines-Dish Accordance

Start by clicking on "Dish Class" to get window in Figure 58. You must enter a category of dish in the box. For example
enter "Poultry" and save. Close, back on the menu "Data", click "Dish and Recipe" to get window in figure 59. Select the class
"Poultry", in the first list and enter the name of the dish into the box. Use the name to the recipe. E.g. "Foie gras baked". | have
not found a dish longer to prepare (24 hours in salt, marinated 48 hours and 15 minutes in the oven!). Clicking "Save", you will
get directly the entry screen for recipe. This entry is optional and you can click "Cancel" to return to previous window. Select a
dish from the list of existing dishes and the button "recipe" will become valid and you will enter or modify a recipe.

& WINe Cellar V08.01 'ﬁw BN
New Dish Class

Mew Class : |F‘nultr}r |

Existing : ’ v]

Fig. 58

Click on "Close" to return to the "Data" menu then on "Wines-Dish Accordance" to get window of figure 60.
In this window you will select a wine and a dish and then click "Add " to create a relationship (Accord) between the dish and the
wine selected. You can of course, have several wines for a dish and several dishes for a wine.

The purpose of this input is to consult, so on main window, click on "Browse™ menu then on "Wines-Dish Accordance™ to get a
window similar to the entry where you can see the agreements previously entered.

¥ WINe Cellar V0801 ‘cavetest mdb'_Bernard Rey [N loconl o= i
News Dishes

Dish Classes :[F‘uul.tr‘,r v]

Mew Dish :|Foie Gras au Four (Baked)

Existing :[ v]

Recipe | Accept | ‘ Close |
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¥ WINe Cellar V08,05 'cavetest.mdb' Bernard Rey — O X
Country Sail
|France j |Eurdeaux j Dish Classes : |‘\.|'nlai||e j
Appellation Dishes
|Sauternes j |Fnie Gras au four j
Title Article Display Recipe | |
Chateau la
Dish classes Dishes
Wine
Tour Blanche j
Colour @ |Blanc j Year : 1997 A
Quantity :
Wines List for selected Dish |
Inttialize | Delete Close
FAMVD4
Fig. 60
¥ WiNe Cellar V08.05 'cavetest.mdb’ Bernard Rey — O >

C Foie Gras au four *
DHD|.§$E|*‘1N|B I U sc| D oo | =

Pour 4 personnes:

: 1 foie gras d'oie cru (400 gr environ)
172 cuillerée i café de paprika

i pincées de "quatre-épices”
2 cuillerées a soupe d'Armagnac

11300 gr de graisse d'oie
N Gros sel marin

1) Salez le foie avec le gros sel et mettez-le au frais pendant 24 heures, puis lavez-le et
épongez-le. Mettez-le a mariner avec le "quatre-épices”, I'Armagnac et le paprika pendant 48
heures. Au cours de la marinade, retournez-le 3 ou 4 fois.

S _ Valdate Cancel

Fig. 61
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Inventory:

From a certain size it becomes necessary to make an inventory from time to time. This allows to catch mistakes,
breakage, loss, forgetfulness ... The easiest way is to have available a list (or several) to which you refer to numbers inventoried
bottles found without forgetting to do it opposite: mark to inventoried bottles with either rubber band (it takes a lot) or with a
marker (erasable), with either a piece of tape or a piece of adhesive label, etc.

You will find in menu "Reports" command "Inventory" that lets you get the window of figure 62. In this window you
can choose sort order of printing report, possibly a selection if you do not want to do a complete inventory, whether to print
certain columns

Some selections are exclusive and make therefore change the following choices.

¥ WINe Cellar V03.05 'cavetest.mdb’ Bernard Rey - O x

T a
() Print one line pe
{3) Print one line per Wine.
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Downloads:

Help Files:

% WIiNe Cellar V02.05 Help Files — O x

Help Files

Télécharger le fichier d'aide en Francais.
Bajar el archivo de ayuda en Espariol.
Download English Help File.

Download het helpbestand in het Nederlands.
Download Deutsch-Hilfedatei.

Baixar o arquivo de ajuda em Portugués.
Scarica il file di aiuto in Italiano.

Baixeu el fitxer d'ajuda en Catala.

Close

08.05.026

Fig. 63

Click on a link to download and install the corresponding Help File (cavexx.chm). The installation is done in the same
directory than the software.

User’s Manual:

& WiNe Cellar V08.05 'cavetest.mdb’ - O x
Download User Manuals
Selection

Languages : |English | Manual language : [English

Formats : |ﬂ4 j

Types : M

File name : [manuelen_a4.pdf |

Validate Close

FDwildA4

Fig. 64

PDF file is opened in your default internet navigator. DOC and DOCX are Office Files
The A5_A4 format is designed to be double-sided (4 pages per sheet) to be bound in the A5 booklet. The manuals exist in three
languages: French, English and Spanish (Castilian).
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Software update:

% WiNe Cellar V08.05 Update — O >

Update

Current Version : 08.05.0215
Mews Version : 08.05.0214

You have the last Version

Download the last version

Download and instal the latest version

Show Updates Details.

Close

FOwldA1l

Fig. 65

The details of the updates appear in the default Internet browser. Download the last version downloads a ZIP file for a later
update of the software. With the Download and install the latest version link you will get the following screen (Figure 66)

¥ 22% Percent complete — O >

Update available

You have the last Version

Shnw Details Current Version : 08.05.0215
Mew Version : 08.05.0213

Received 506,88 Kb of 2308,52 Kb

Update Cancel Update Close

FDwid01

Fig. 66

Show _Details: display the latest changes.

Update: click to start the download and installation of the update.
Cancel_Update: while downloading, you can stop the operation.
Close: To move to the next screen without updating.
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Languages:

? WiNe Cellar V02.05 'cavetest.mdb’ — O x

Select a language and click on Validate.

4 WiNe Cellar v08.05 — O X

Fig. 68

Click on Start, The update is automatic.
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Back to previous software version:

Click on the "Maintenance™ menu and then on "Previous Version" command to get:

i"‘ Cave Bodega WINe Cellar

Backup available

Current Version : 08.05.0215
Return to the previous version.

¥ou want to return to the previous version.
You can return to this version automatically
by selecting it in the list and
by clicking the button 'Previous Version'

08.05.0210 ~  Select a version
08.05.0209
08.05.0208
08.05.0207 v
Remove versions Previous Version Close

Fcaves

Fig. 66

Select a version from the list and click the button "Previous version"

Restore saved files

Click the "File" menu and then the command "Restore"

¥ WINe Cellar V08.05 *cavetest.mdb’ Bernard Rey — O x
Restore Data
0:\Saves\Cave\SaveCave20161226160809.MBK
Open file...
Restore Farameters
0:\Saves\Cave\SaveCave20161226160809.PRM ’
Open Fie...
- o Restore Cancel

Fig. 70

In the same way that we backup (Fig. 57), we can restore the data and settings. Attention: all that was entered between backup
and restore is lost.
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Miscellaneous (general)

Contextual menu :
2 WiNe Cellar V02.05 Help Files — O X

MNone
Aqua Marine

Light Cyan Francais.

Mavajo White e
spanol.

Light Salmon
Original lmage
New Image et Nederlands.

Zolor of Titles

Proportional enlargemnent L
Close this menu. 2
Baixeu el fitxer d'ajuda en Cal 3
4
5 Fr— :
FDwidA3 | Close

Fig. 71
Wallpapers:

None  Windows standard color (gray).
Aqua Marine:  Green

Light Cyan : Light blue

Navajo White :  light orange

Light Salmon :  Orange-red

Original image: The one provided during the development of the program and provided in the "Images"” directory of the
software.

New image: The one of your choice. To tone down the colors, | use PaintShop Pro, but it doesn't have to be.
Title colors: If the image prevents you from seeing the titles correctly, you can change their color.
Proportional Enlargement:

From 1 to 5 from the largest to the smallest. You can click on one of the enlargements or, if the one checked is
appropriate for you, on the small square at the top right of the form. The value is kept in the form parameters.
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Viewed, annotated, managed, simply close "WINe Cellar" by clicking on the button "Exit" or by calling the command
"Exit" from the File menu. "WINe Cellar" will propose you to save your database on a disk (or elsewhere), back up, useful in
case of "Crash" HDD, or mishandled, that can happen.

One last point before | leave you alone with "WINe Cellar", if you have a problem, a doubt, press "F1" and you will
display the corresponding help. This help file works like any Windows Help files with hyperlinks - and was created from
screenshots of "WINe Cellar". You can also access the help screen by the command "Index" in menu "Help". In that menu you
will find commands "Hot Line" to contact the author for any help and the eternal "about" remembering the version, the software
name and that of the author, and your number license with your name and address.

"Voila", it remains to me to wish you a good tasting with this tool that was missing from the palette of the perfect
Sommelier.

My contact information: Mr. REY Bernard
22 rue de Pénide
33460 ARSAC
FRANCE
Phone: (33) 556 58 66 27

(33) 6 82 70 20 07

e-mail: contact@rey-bernard.fr

© 1993 - 2020 B. Rey
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